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Paper Set 1 · 28 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A boat going downstream covers a distance of 21 km in 3 hours and
takes 7 hours to cover the same distance upstream. What is the
speed (in km/hr) of the stream?

A.  1

B.  2

C.  3

D.  4

✓

Q2 Quant
A and B started a business by investing ₹30,000 and ₹20,000
respectively. If the total profit at the end of the year is ₹25,000, then
what is B’s share of profit?

A.  ₹10,000

B.  ₹12,000

C.  ₹13,000

D.  ₹15,500

✓

Q3 Quant
Which among the following pairs of numbers are co-primes?

A.  (45,87)

B.  (77,120)

C.  (54,84)

D.  (117,162)

✓

Q4 Quant
A cylindrical vessel has diameter 30 cm and unknown height. Water
is poured into two identical cylindrical vessels, each with radius 10
cm and height 45 cm, filling them completely. Find the height of the
original cylinder.

A.  45 cm

B.  30 cm

C.  35 cm

D.  40 cm

✓

Q5 Quant
Manju purchased a book for ₹380 and marked it up by 20%. Later
she sold it at a discount of 10%. Find her profit percentage.

A.  5%

B.  8%

C.  9%

D.  12%

✓

Q6 Quant
One car travels at 70 m/s and two other cars travel at 30 m/s more
than the first car, what is the average speed of all three cars?

A.  80 m/s

B.  90 m/s

C.  100 m/s

D.  110 m/s

✓

Q7 Quant
If x + 7y + 6z = 28; 3x – 4y + z = 7; 2x – z + 3y = 19, then what is the
value of x + y + z?

A.  5

B.  7

C.  9

D.  10

✓

Q8 Quant
Find the mode of the given data.

Class interval 0-4 4-8 8-12 1

Frequency 2 5 4 3

A.  5

B.  6

C.  7

D.  8

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q9 Quant
Dev and Tej started a business investing amounts of ₹1,680 and
₹2,380, respectively. If Dev's share in the profit earned by them is
₹960, what is the total profit (in ₹) earned by them together?

A.  2,320

B.  2,294

C.  2,464

D.  2,302

✓

Q10 Quant
Subtracting 15% of X from X is the same as multiplying X by:

A.  0.85

B.  0.15

C.  0.5

D.  0.015

✓

Q11 Quant

Given that 360.93 = x, 360.17= y and xz = y2, then the value of z is
close to:3064

A.  0.37

B.  0.68

C.  1.68

D.  1.07

✓

Q12 Quant
A shopkeeper fixes the marked price of an item at 30% above its
cost price. What percentage of discount on the marked price should
be allowed to gain 4%?

A.  20%

B.  22%

C.  21%

D.  23%

✓

Q13 Quant
Varun has ₹1302 with him. He divided it amongst his sons, Ashish
and Arun, and asked them to invest it at 10% rate of interest
compounded annually. It was seen that Ashish and Arun got the
same amount after 16 and 17 years, respectively. How much money
(in ₹) did Varun give Arun?10074

A.  620

B.  682

C.  470

D.  782

✓

Q14 Quant
Let C be a circle with centre O and PQ be a chord of C such that PQ
subtends an angle 70° at O. Let S be a point on minor arc PQ. Find
∠PSQ.

A.  135°

B.  40°

C.  145°

D.  35°

✓

Q15 Quant
In △ABC, points D and E lie on sides AB and BC, respectively, such
that DE∥AC. Also, BD = 24 m, AD = x m, BE = y m, EC = 36 m and x =
6y. If the area of △ABC is 432 m2, find the area of △BDE.

A.  54 m2

B.  144 m2

C.  72 m2

D.  27 m2

✓

Q16 Quant
₹610 amounts to ₹970 at a certain rate of simple interest in 2 years.
Find the interest (in ₹) for the given 2 years.

A.  360

B.  370

C.  355

D.  375

✓

Q17 Quant
After decreasing 40% in the actual cost price, the reduced cost price
of an article is ₹1068. The actual cost price of the article (in ₹) is:

A.  1780

B.  1720

C.  1670

D.  1640

✓

Q18 Quant
One pipe can completely fill a tank in 15 minutes, while another pipe
can empty completely filled tank in 90 minutes. If both the pipes are
operated together when the tank is empty, how long (in minutes)
will it take to fill two-thirds of the tank?

A.  12

B.  14

C.  18

D.  16
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✓

Q19 Quant

A.  

B.  

C.  

D.  

✓

Q20 Quant
X, Y, and Z become partners in a business by investing money in the ratio of 5 : 7 : 6. Next year, they increased their investments by 26%, 20%,
and 15%, respectively. In what ratio should the profit earned during the second year be distributed?

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
Pitt’s India Act of 1784 introduced which unique administrative
structure for East India Company governance?

A.  Federal government

B.  Dual System of Government

C.  Mono System of Government

D.  Triangular authority

✓

Q22 GA
Who became India’s 87th Grandmaster after earning his third and
final GM norm at the La Plagne International Chess Festival in
France in July 2025?

A.  Harikrishnan A Ra

B.  Srihari L R

C.  Gukesh D

D.  Praggnanandhaa R

✓

Q23 GA
In which city did Union Minister Amit Shah inaugurate India’s largest
and most advanced sports complex in September 2025?

A.  Lucknow

B.  Jaipur

C.  New Delhi

D.  Ahmedabad

✓

Q24 GA
As per the Odisha Economic Survey 2024–25 (Advance Estimates),
which sub-sector accounted for the highest percentage share in
Agriculture and Allied Sector Gross Value Added (GVA) in 2024–25?

A.  Crops

B.  Livestock

C.  Forestry and Logging

D.  Fishing and Aquaculture
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✓

Q25 GA
In the Budget for the financial year 2026–27, which Indian state
proposed restricting the use of social media by children below 16
years of age in order to address digital addiction, mental health
concerns, and declining academic performance among minors?

A.  Tamil Nadu

B.  Karnataka

C.  Maharashtra

D.  Uttar Pradesh

✓

Q26 GA
Tides on Earth occur mainly due to:

A.  Gravitational pull of the Moon and the Sun

B.  Rotation of Earth on its axis

C.  Wind pressure over ocean surface

D.  Uneven heating of the Earth

✓

Q27 GA
The composition of each new substance is _____________.

A.  Always fixed

B.  Varying

C.  Dependent on temperature

D.  Dependent on pressure

✓

Q28 GA
If the xylem fibres were absent in a tall tree, which structural
consequence would occur first?

A.  The tree would stop growing taller.

B.  The trunk and branches would droop.

C.  The rate of photosynthesis would increase.

D.  The roots would fail to absorb minerals.

✓

Q29 GA
Along with ASP Rabindra Kumar Panda, which other Odisha Police
officer received the President’s Medal for Distinguished Service in
August 2025?

A.  Commandant Naresh Kumar Patel

B.  Inspector A Srinibas Dora

C.  Constable Chinmayee Rout

D.  SI Amaresh Narendra

✓

Q30 GA
The world’s longest international land border is shared between
which two countries?

A.  Brazil–Argentina

B.  USA–Canada

C.  India–China

D.  Russia–China

✓

Q31 GA

The 2025 Gaza Peace Summit (also known as the
Sharm El-Sheikh Summit) was held on 13
October 2025. Which of these statements is
correct?

A.  Both Israel and Hamas attended the
summit

B.  It resulted in a detailed binding treaty being
adopted

C.  It was co-chaired by the U.S. and Egypt

D.  It focused exclusively on climate change

✓

Q32 GA
Who chaired the high-level review meeting at Lok Seva Bhawan on
Odisha’s heritage conservation and development plans in August
2025?

A.  Chief Minister Mohan Charan Majhi

B.  Deputy Chief Minister Pravati Parida

C.  Law Minister Prithviraj Harichandan

D.  Culture Minister Suryabanshi Suraj

✓

Q33 GA
Effective disaster management primarily enables communities to:

A.  Completely eliminate the occurrence of all natural hazards

B.  Permanently prevent changes in climatic and weather
patterns

C.  Adapt to natural conditions and utilise them to their
advantage

D.  Exercise full control over geological and environmental
processes
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✓

Q34 GA
The idea of including “coming generations’ needs” reflects the
concept of:

A.  Fiscal policy

B.  Market equilibrium

C.  Intergenerational equity

D.  Economic liberalization

✓

Q35 GA
Why is Neeraj Chopra's gold medal at Tokyo 2020 considered a
milestone for Indian track and field history?

A.  He broke a world record at the Olympics

B.  It was the first Olympic medal in swimming for India

C.  It was the first Olympic medal in athletics for India

D.  He became the youngest Indian Olympic medalist

✓

Q36 GA
Which of the following islands is located nearer to Indonesia and
Thailand?

A.  Andaman & Nicobar

B.  Sriharikota

C.  Lakshwadweep

D.  Majuli islands

✓

Q37 GA
Which hill range forms the easternmost extension of the Himalayas
in India?

A.  Nilgiri Hills

B.  Purvanchal ranges

C.  Aravalli Range

D.  Satpura Range

✓

Q38 GA
Utkal Ratna Biswanath Mishra is most commonly associated with
which of the following?

A.  Santhal Movement

B.  Oriya Movement

C.  Satnami Rebellion

D.  Paik Rebellion

✓

Q39 GA
Which of the following acts/legislations abolished diarchy in the
provinces and introduced ‘provincial autonomy’ in its place?

A.  Government of India Act, 1909

B.  Government of India Act, 1919

C.  Government of India Act, 1935

D.  Indian Councils Act, 1892

✓

Q40 GA
Which of the following texts is/are part of the Buddhist Tripitaka?

A.  Rig Veda

B.  Upanishads

C.  Sutta Pitaka

D.  Manusmriti
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English

✓

Q41 English
Complete the sentence with the most appropriate article:
In the realm of cybersecurity, staying ahead of ____ latest threats is a never ending challenge for experts.

A.  no article needed

B.  the

C.  an

D.  a

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words in the given sentence.

Despite his best efforts along with hours of study and tutoring, Manit's grades remained something that seemed beyond correction, showing
no signs of improvement.

A.  incontrovertible

B.  incorrigible

C.  intolerable

D.  incompatible

✓

Q43 English
Change the sentence from passive voice to active voice.

Explanatory letters are being written to Elizabeth by Mr. Darsey.

A.  Mr. Darsey is writing explanatory letters to Elizabeth.

B.  Mr. Darsey writes explanatory letters to Elizabeth.

C.  Mr. Darsey was writing explanatory letters to Elizabeth.

D.  Mr. Darsey will write explanatory letters to Elizabeth.

✓

Q44 English
Find the antonym of the word given in bold:
The news cast a sombre mood over the entire community.

A.  optimstic

B.  gloomy

C.  sad

D.  dismal

✓

Q45 English
Select the option that uses the correct form of the past tense.

A.  The artist paint a sunset on the cliff yesterday.

B.  The campers were walks along the riverbank in the evening.

C.  The hikers walked through the rainforest until sunset.

D.  The surfers rided the giant waves near the coast last summer.
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✓

Q46 English
Choose the correct sentence written in indirect speech from the following options:

A. The doctor advised, "You must take this medicine twice a day."
B. "Will you be joining us for lunch tomorrow?" asked Maria.
C. The teacher explained that the exam would cover chapters four through six.
D. The sign clearly stated, "No parking is allowed on this street."

A.  The doctor advised, "You must take this medicine twice a day."

B.  "Will you be joining us for lunch tomorrow?" asked Maria.

C.  The teacher explained that the exam would cover chapters four through six.

D.  The sign clearly stated, "No parking is allowed on this street."

✓

Q47 English
Select the most appropriate option to fill in the blank.

The professor delivered a lecture so _____ that even the most distracted students paid attention.

A.  tedious

B.  irrelevant

C.  captivating

D.  monotonous

✓

Q48 English
Select the correct idiom from the following options for the underlined segment of the given sentence.
After missing the deadline, Sarah had to accept the consequences and explain her mistake to the manager.

A.  face the music

B.  beat around the bush

C.  hit the nail

D.  bite a bullet

✓

Q49 English
In the given question, a statement is divided into different segments. The first segment is fixed. Rearrange the other segments to form a
coherent statement.

The Great Pyramid of Giza/ and a symbol of Egyptian greatness(P)/ located near Cairo in Egypt(Q)/ was built during King Khufu’s reign(R)/ and
remains the last surviving Wonder of the ancient world(s)/

A.  PRSQ

B.  SRPQ

C.  QRSP

D.  PQRS
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✓

Q50 English

Choose the option which has the correct spelling of the underlined word in the given sentence.

She has a very bizzare sense of humour.

A.  She has a very bizzarre sense of humour.

B.  She has a very bizerre sense of humour.

C.  She has a very bizare sense of humour.

D.  She has a very bizarre sense of humour.

✓

Q51 English

Replace the given word segment with the correct idiom.
To describe a situation or problem exactly

A.  To the letter

B.  By and large

C.  To fan the flame

D.  Add fuel to the fire

✓

Q52 English

Read the following passage carefully and answer the questions that follow.
The global proliferation of plastic debris has escalated into a systemic crisis, with an astronomical volume of waste—comparable to the diurnal
discharge of 2,000 refuse vehicles—inundating our primary aquatic arteries. Annually, an estimated 19 to 23 million tonnes of polymer pollutants
infiltrate marine and freshwater ecosystems, instigating a profound ecological destabilization. This contamination transcends mere aesthetic
degradation; it fundamentally reconfigures natural habitats and impedes the regenerative resilience of ecosystems struggling against climatic
shifts. Consequently, this disruption precipitates a deleterious ripple effect on human civilization, undermining food security, jeopardizing
livelihoods, and eroding collective social well-being. As evidenced by UNEP research, plastic pollution is not an isolated phenomenon but an
interconnected threat. It necessitates a holistic analytical framework that evaluates plastic-related risks in tandem with collateral environmental
stressors, such as biodiversity loss and resource depletion. Addressing this exigency requires acknowledging the intricate nexus between
synthetic waste and the broader anthropogenic pressures currently reshaping our planet’s biosphere.

Identify the predominant tone of the given passage.

A.  Analytical and Urgent

B.  Alarmist and Hyperbolic

C.  Apathetic and Detached

D.  Cynical and Sarcastic

✓

Q53 English
Which of the following is the central theme of the passage?

A.  The transition toward a circular economy is necessary to mitigate the risks associated with resource depletion and the loss of
biodiversity.

B.  The aesthetic degradation of marine habitats has forced international organizations to prioritize food security over plastic waste
management.

C.  The primary cause of global ecological destabilization is the daily discharge of polymer pollutants into the world’s major freshwater
arteries.

D.  The escalating volume of plastic waste requires a holistic approach to address its interconnected impact on both ecosystems and
human society.
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✓

Q54 English
Which of the following can be the suitable title for the passage?

A.  The Anthropogenic Pressures of Aquatic Habitat Transformation

B.  The Technical Framework for Evaluating Global Refuse Discharge

C.  The Systemic Nexus of Plastic Pollution and Global Ecosystems

D.  The Economic Consequences of Increasing Marine Polymer Waste

✓

Q55 English
Why is plastic contamination considered a threat beyond simple aesthetic degradation?

A.  It generates significant costs for local tourism.

B.  It requires expensive machinery for global removal.

C.  It reconfigures habitats and lowers ecosystem resilience.

D.  It leads to the creation of new marine landmasses.

✓

Q56 English
What type of analytical framework does UNEP research suggest for addressing plastic pollution?

A.  A localized strategy focusing on regional waste management

B.  A holistic framework evaluating risks with other stressors

C.  A corporate-led initiative prioritizing recycled materials

D.  A financial model targeting the reduction of production costs

✓

Q57 English
Select the most suitable option to complete the sentence.
The mountain view was so ______ that we stood in silence, admiring it for minutes.

A.  noisy

B.  breathtaking

C.  ordinary

D.  broken

✓

Q58 English
Choose the correct antonym of the underlined word in the given sentence.

His comments during the debate were quite constructive, helping improve the overall argument.

A.  casual

B.  sarcastic

C.  destructive

D.  perceptive
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✓

Q59 English
Select the option that can be used as a one-word substitute for the underlined group of words.

Ramani Durvasula, a psychologist and author specialising in narcissism and narcissistic abuse, says that people who are unfairly blamed for the
wrongdoings of others are at risk of a host of mental health issues, including complex trauma, anxiety, self-doubt, and self-blame.

A.  scapegoats

B.  fugitives

C.  martyrs

D.  scarecrows

✓

Q60 English
The following sentence has been split into segments. The first segment, marked as (1), is fixed. Rearrange all the other segments to form a
coherent statement.

(1) Despite the increasing
(P) new customers by offering personalised services, utilising
(Q) responding quickly to feedback
(R) advanced marketing techniques, and
(S) competition in the industry, the startup consistently attracts

A.  PSRQ

B.  SPRQ

C.  QRPS

D.  RPQS

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ପାର୍କ ରେ ଥି ବା ଫୁ ଲଗୁ ଡ଼ି କ ବହୁ ତ "ସୁ ନ୍ଦର" ଅଟେ।

A.  କୁ ରୁ ପ

B.  ଆକର୍ଷ ଣୀୟ

C.  ନି ରାକାର

D.  ଅନ୍ଧକାର

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ଗଙ୍ଗା ନଦୀକୁ  "ପବି ତ୍ର " ମନାଯାଏ।

A.  ଅଶୁ ଦ୍ଧ

B.  ଶୁ ଦ୍ଧ

C.  ଭୟଙ୍କର

D.  ଅସୁ ନ୍ଦର
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✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ପୃ ଥି ବୀ ସୂ ର୍ଯ୍ୟ  ଚାରି ପଟେ ପରି କ୍ର ମଣ କରେ ।

A.  The Earth revolves around the Sun.

B.  Earth revolve around sun.

C.  The Earth revolving the Sun.

D.  Earth is revolve on Sun.

✓

Q64 Odia
ନି ମ୍ନୋ କ୍ତ ବାକ୍ୟର ଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ ।
"ଭାରତରେ ବି ଭି ନ୍ନ ଧର୍ମ ର ଲୋକ ବାସ କରନ୍ତି  ।"

A.  People of different religions lived in India.

B.  People of different religions will live in India.

C.  People of different religions live in India.

D.  People of different religions are living in India

✓

Q65 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ସୂ ତା

A.  ମାତା

B.  ପି ତା

C.  ଭ୍ରା ତା

D.  ତନୟା

✓

Q66 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ସବୁ  ସରକାରୀ କଲେଜରେ ଅନେକ ବୈ ଜ୍ଞାନି କ ପରୀକ୍ଷାଗାର ରହି ଛି  ।

A.  All government colleges had many scientific laboratories.

B.  All government colleges have many scientific laboratories.

C.  There are many scientific laboratories in government colleges.

D.  All government colleges have scientific laboratories.

✓

Q67 Odia
ତୁ ମେ ପାଠ ପଢି  ଯଶସ୍ଵୀ ହୁ ଅ । ଏହି  ବାକ୍ୟଟି ରେ "ପଢି " କେଉଁ  ପ୍ର କାରର ଅସମାପି କା କ୍ରି  ୟା ?

A.  ହେତୁ ସୂ ଚକ ଅସମାପି କା କ୍ରି  ୟା

B.  ପୂ ର୍ବ କାଳସୂ ଚକ ଅସମାପି କା କ୍ରି  ୟା

C.  କାଳସୂ ଚକ ଅସମାପି କା କ୍ରି  ୟା

D.  ବି ରୋଧସୂ ଚକ ଅସମାପି କା କ୍ରି  ୟା
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✓

Q68 Odia
"ସେ ଜଣେ ଶି କ୍ଷକ ଅଟନ୍ତି " - ଏହି  ବାକ୍ୟରେ 'ଅଟନ୍ତି ' କେଉଁ  ଧାତୁ ରୁ  ନି ଷ୍ପନ୍ନ?

A.  ଅଟ୍

B.  ଅସ

C.  ଅଛ୍

D.  ଅଟ

✓

Q69 Odia
ପଢ୍ +ଆ=ପଢା ଉଦାହରଣରେ 'ପଢ୍ ' କଣ ସୂ ଚନା କରୁ ଛି  ?

A.  ପ୍ର ତୟ

B.  ବି ଶେଷଣ

C.  ଅବ୍ୟୟ

D.  ଧାତୁ

✓

Q70 Odia
ନି ମ୍ନ ଲି ଖି ତ ବାକ୍ୟଗୁ ଡି କରେ ଭୁ ଲ ବନାନ ଚି ହ୍ନଟ କରି  ଠି କ୍  ବାକ୍ୟ ବାଛ ।

A.  ଦି ଗାମ୍ବର ଶଦ୍ଦଟି  ତ୍ୟାଗମୟ ଜୀବନଶୈ ଳୀକୁ  ସୂ ଚି ତ କରେ ।

B.  ଦି ଗମ୍ଭର ଶଦ୍ଦଟି  ତ୍ୟାଗମୟ ଜୀବନଶୈ ଳୀକୁ  ସୂ ଚି ତ କରେ ।

C.  ଦି ଗାମ୍ଭର ଶଦ୍ଦଟି  ତ୍ୟାଗମୟ ଜୀବନଶୈ ଳୀକୁ  ବୁ ଝାଏ ।

D.  ଦି ଗମ୍ବର ଶବ୍ଦଟି  ତ୍ୟାଗମୟ ଜୀବନଶୈ ଳୀକୁ  ସୂ ଚି ତ କରେ ।

✓

Q71 Odia

ପ୍ର ଦତ୍ତ ଅନୁ ଚ୍ଛେଦ ଆଧାରରେ ନି ମ୍ନ  ପ୍ର ଶ୍ନ ଗୁ ଡ଼ି କର ଉପଯୁ କ୍ତ ଉତ୍ତର ନି ର୍ଦ୍ଧା ରଣ କରନ୍ତୁ|
ପୁ ସ୍ତକ ପଠନ କେବଳ ଏକ ସାଧାରଣ ଅଭ୍ୟାସ ନୁ ହେଁ , ବରଂ ଏହା ହେଉଛି  ଅପାର ଜ୍ଞାନ ଏବଂ ଅସୀମ କଳ୍ପନା ଜଗତର ଏକ ପ୍ର ଶସ୍ତ ପ୍ର ବେଶ ଦ୍ୱାର। ପୁ ସ୍ତକଗୁ ଡ଼ି କ ଜଣେ ପାଠକକୁ  ବି ଶ୍ୱର ବି ଭି ନ୍ନ ପ୍ରା ନ୍ତର
ସଂସ୍କୃତି , ଗୌରବମୟ ଇତି ହାସ ଏବଂ ଭି ନ୍ନ ଭି ନ୍ନ ଦୃ ଷ୍ଟି କୋଣ ସହି ତ ନି ବି ଡ଼ ଭାବେ ପରି ଚି ତ କରାଇଥାଏ। ଯେଉଁ  ବ୍ୟକ୍ତି ମାନେ ନି ୟମି ତ ପଠନ ଅଭ୍ୟାସ ଜାରି  ରଖନ୍ତି , ସେମାନଙ୍କର ଶବ୍ଦକୋଷ ଅଧି କ
ସମୃ ଦ୍ଧ ହେବା ସହ ଏକାଗ୍ର ତା ଶକ୍ତି ରେ ଉଲ୍ଲେଖନୀୟ ଉନ୍ନତି  ପରି ଲକ୍ଷି ତ ହୋଇଥାଏ। କେବଳ ସେତି କି  ନୁ ହେଁ , ପଠନ ଦ୍ୱାରା ଜଣେ ବ୍ୟକ୍ତି ର ବି ଶ୍ଳେଷଣାତ୍ମକ ଦକ୍ଷତା ଏବଂ ଚି ନ୍ତା କରି ବାର ଶକ୍ତି  ମଧ୍ୟ
ବହୁ ଗୁ ଣି ତ ହୋଇଥାଏ। ମାନସି କ ସ୍ୱାସ୍ଥ୍ୟ ଦୃ ଷ୍ଟି କୋଣରୁ  ଦେଖି ଲେ, ପଢି ବା ଦ୍ୱାରା ଦୈ ନନ୍ଦି ନ ଜୀବନର ଚାପ ଓ ଉଦ୍ବେ ଗ ହ୍ରା ସ ପାଇଥାଏ। ଏହା ପାଠକମାନଙ୍କୁ  ନି ଜ ଜୀବନ ଏବଂ ଭାବନାକୁ  ନୂ ତନ
ଅନୁ ଭୂ ତି  ସହ ତୁ ଳନା କରି ବାର ସୁ ଯୋଗ ଦେଇ ସମାଜ ପ୍ର ତି  ସହାନୁ ଭୂ ତି  ଓ ମାନବି କତା ବୃ ଦ୍ଧି  କରି ବାରେ ସାହାଯ୍ୟ କରେ। ଆଜି ର ଏହି  ଅତ୍ୟାଧୁ ନି କ ଡି ଜି ଟାଲ୍  ଯୁ ଗରେ, ସୂ ଚନା ହାସଲ କରି ବା ଅତି
ସହଜ ହୋଇପଡ଼ି ଛି । ପାରମ୍ପରି କ ଭୌତି କ ପୁ ସ୍ତକ ହେଉ କି ମ୍ବା ଆଧୁ ନି କ ଇ-ପୁ ସ୍ତକ, ଉଭୟ ମାଧ୍ୟମ ଆଜି  ପାଠକମାନଙ୍କୁ  ସମଗ୍ର  ବି ଶ୍ୱର ସୂ ଚନା ଏବଂ ଜ୍ଞାନର ଭଣ୍ଡାର ପାଖରେ ଅତି  ସହଜରେ ପହଞ୍ଚାଇ
ଦେଇଛନ୍ତି । ପଠନ ହିଁ ଜଣେ ବ୍ୟକ୍ତି କୁ  ପ୍ର କୃ ତ ଅର୍ଥ ରେ ସଚେତନ ଓ ସମୃ ଦ୍ଧ କରି  ଗଢ଼ି ତୋଳେ।

ଏହି  ଅନୁ ଚ୍ଛେଦର ସର୍ବୋ ତ୍ତମ ଶୀର୍ଷ କ କ’ଣ ହେବ?

A.  ପୁ ସ୍ତକ ଏବଂ କଳ୍ପନା

B.  ଜ୍ଞାନର ଗୁ ପ୍ତତା

C.  ପଠନର ଶକ୍ତି

D.  ଡି ଜି ଟାଲ୍  ଯୁ ଗରେ ପୁ ସ୍ତକ

✓

Q72 Odia
ଆଜି ର ଡି ଜି ଟାଲ ଯୁ ଗରେ, ଭୌତି କ ପୁ ସ୍ତକ ଏବଂ ଇ-ପୁ ସ୍ତକ ଉଭୟ କେଉଁ ଟି କୁ  ସହଜ ପ୍ର ବେଶ ପ୍ର ଦାନ କରେ?

A.  ସୂ ଚନା

B.  ପରୀକ୍ଷଣ

C.  ଗବେଷଣା

D.  ଆବି ଷ୍କାର
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✓

Q73 Odia
ପଢି ବାର ଗୋଟି ଏ ଲାଭ ନାମ ଦି ଅନ୍ତୁ ଯାହା ଅନୁ ଛେଦରେ ଉଲ୍ଲେଖ କରାଯାଇ ନାହିଁ।

A.  ଚାପ ହ୍ରା ସ କରେ

B.  ଜ୍ଞାନ ବୃ ଦ୍ଧି  କରେ

C.  ଏକାଗ୍ର ତା ଉନ୍ନତ କରେ

D.  ବ୍ୟକ୍ତି ତ୍ୱ ବି କାଶ କରେ

✓

Q74 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ସାରେ ପୁ ସ୍ତକ ଦ୍ୱାରା ଆମକୁ  କେଉଁ  ଧାରଣା ପରି ଚି ତ କରାଯାଏ ନାହିଁ?

A.  ସଂସ୍କୃତି

B.  ଇତି ହାସ

C.  ଦୃ ଷ୍ଟି କୋଣ

D.  ବ୍ୟକ୍ତି ତ୍ୱ

✓

Q75 Odia
କେଉଁ ଟି କୁ  ଜ୍ଞାନ ଏବଂ କଳ୍ପନାର ପ୍ର ବେଶ ଦ୍ୱାର ଭାବରେ ବି ବେଚନା କରାଯାଏ?

A.  ପୁ ସ୍ତକ

B.  ପଠନ

C.  ଶି କ୍ଷଣ

D.  ସୂ ଚନା

Computer

✓

Q76 Computer
Which of the following helps in protecting computer applications
from unauthorized access?

A.  Antivirus software

B.  Facebook

C.  Password protection

D.  Screen saver

✓

Q77 Computer
A student is learning text manipulation in MS Word 2021. Which
statement is True or False regarding Cut, Copy, and Paste?
(i) Both Cut (Ctrl + X) and Copy (Ctrl + C) place the selected text onto
the Clipboard.
(ii) The standard Paste command (Ctrl + V) always forces the inserted
text to match the destination document's formatting, overriding the
original formatting.

A.  (i) True, (ii) True

B.  (i) True, (ii) False

C.  (i) False, (ii) True

D.  (i) False, (ii) False

✓

Q78 Computer
Which PowerPoint tab contains the options to apply transitions
between slides?

A.  Home

B.  Insert

C.  Transitions

D.  Design

✓

Q79 Computer
If a student receives an important email and wants to send a copy of
that entire message, including all its content and attachments, to a
third party who was not an original recipient, they should select the
___________________ command.

A.  Reply All

B.  Reply

C.  Forward

D.  Archive
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✓

Q80 Computer
To add text to a slide in a new, blank MS PowerPoint presentation,
what is the first action you must usually take on the default title
slide?

A.  Double-click anywhere on the slide and start typing.

B.  Click the Insert tab and choose the Text Box tool.

C.  Click inside one of the existing placeholder boxes labeled
"Click to add title" or "Click to add subtitle".

D.  Press the Spacebar key five times to activate the typing area.

✓

Q81 Computer
When attaching a file from OneDrive or SharePoint in Outlook, what
is the advantage of sending it as a link instead of a copy?

A.  It increases the size of your email

B.  It keeps your message size smaller and allows setting
sharing permissions

C.  It removes the need for an internet connection

D.  It automatically deletes files after sending

✓

Q82 Computer

In context of using the Help menu in MS Word 2021, match Actions
in Column A with their correct descriptions in Column B.

Column A Column B

1. F1 Key
a) Offers a search field to type questions or
commands in the Help pane

2. Tell Me
Feature

b) Shows a collection of frequently used help
topics and FAQs

3. Online
Support

c) Launches the Microsoft Word Help window for
detailed guidance

4. Help Tab in
Ribbon

d) Provides access to Microsoft’s official online
help and support services

A.  1–c, 2–a, 3–d, 4–b

B.  1–a, 2–d, 3–b, 4–c

C.  1–d, 2–b, 3–a, 4–c

D.  1–b, 2–c, 3–d, 4–a

✓

Q83 Computer
Which of the following is an application of computers in the field of
education?

A.  Online learning platforms

B.  ATMs

C.  Robotics

D.  Weather satellites

✓

Q84 Computer
What does the abbreviation MAN stand for in computer networking?

A.  Main Area Network

B.  Metropolitan Area Network

C.  Multiple Access Network

D.  Managed Application Network

✓

Q85 Computer
How can a slideshow be set to loop continuously in MS PowerPoint?

A.  Enable the 'Loop Continuously Until Esc' option in the Set Up
Slide Show menu.

B.  Use the Outline View.

C.  Manually restart the slideshow after it ends.

D.  Convert the PowerPoint to video format.

✓

Q86 Computer
A user creates a formula in cell D5 =B5*C5 + A1 and copies it to cell
D6. Assuming no absolute references are used, which part of the
formula is most likely to produce an unintended result?

A.  B5 changes incorrectly to B6

B.  A1 shifts and may cause a logic error

C.  Multiplication occurs before addition

D.  The formula will stop working after being copied

✓

Q87 Computer
When evaluating memory bandwidth, which parameter is most
likely to improve as a direct result of increasing the RAM’s clock
frequency?

A.  Screen resolution

B.  Latency of RAM

C.  Data throughput

D.  Fan speed

✓

Q88 Computer
What happens when you delete a row in an MS Excel spreadsheet?

A.  Existing rows shift up.

B.  Existing rows shift down.

C.  Existing columns shift left.

D.  Nothing changes.
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✓

Q89 Computer
In Microsoft Word 2021, which is the correct method to define a
custom bullet using a symbol or image?

A.  Go to Insert tab → Click Shapes → Insert a bullet shape for
each item

B.  Go to References tab → Click Insert Footnote → Select Bullet
from menu

C.  Go to Layout tab → Click List Options → Add Bullet Symbol

D.  Go to Home tab → Click the dropdown arrow next to Bullets →
Select 'Define New Bullet'

✓

Q90 Computer
How can a user quickly delete chosen rows using a keyboard
shortcut in MS Excel?

A.  Ctrl + D

B.  Ctrl + F1

C.  Ctrl + C

D.  Ctrl + −

Reasoning

✓

Q91 Reasoning
Six people, P, Q, R, S, T and U, are sitting in a straight line, facing the
north. Q is sitting to the immediate right of T. R is an immediate
neighbour of T and P. S is not sitting at any of the extreme ends,
while U is not sitting at the extreme right end.
Who is sitting at the extreme right end of the line?

A.  P

B.  Q

C.  T

D.  R

✓

Q92 Reasoning
In a certain code language,
Y + Z means ‘Y is the sister of Z’
Y – Z means ‘Y is the son of Z’
Y × Z means ‘Y is husband of Z’
Y ÷ Z means ‘Y is the daughter of Z’
Based on the above, how is A related to F if ‘A + B − C × D ÷ F’?2337

A.  Daughter's daughter

B.  Mother’s mother

C.  Mother

D.  Daughter

✓

Q93 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?
KRC69, OVF62, SZI55, WDL48, ?

A.  AHO 41

B.  BGN 42

C.  ZIP 41

D.  AIN 42

✓

Q94 Reasoning
Each of the digits in the number 3157864 is arranged in ascending
order from left to right. The position of how many digits will remain
unchanged as compared to that in the original number?

A.  None

B.  One

C.  Two

D.  Three
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✓

Q95 Reasoning
Seven boxes B, C, D, E, G, H and I are kept one over the other but not
necessarily in the same order. No box is kept below C. Only two
boxes are kept between H and C. Only B is kept above G. D is kept at
some place below E but at some place above I. How many boxes are
kept between I and E?

A.  One

B.  Two

C.  Three

D.  Four

✓

Q96 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.

GUX : FYZ
KTI : JXK

A.  EFI : DJJ

B.  OET : NIV

C.  LIQ : KLS

D.  VOK : USL

✓

Q97 Reasoning
In a certain code language, 'JMWE' is coded as '20-26-46-10' and
'SJCY' is coded as '38-20-6-50'.
What is the code for 'TKHD' in the given code language?

A.  40-22-16-8

B.  35-19-20-9

C.  43-21-18-9

D.  41-21-18-9

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: All hammers are jacks. All hammers are metals.
Conclusion (I): Some jacks are metals.
Conclusion (II): All metals are hammers.

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow

✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
man out is not based on the number of consonants/vowels or their
position in the letter-cluster.)5681

A.  PQ-TU

B.  GH-JK

C.  DE-GH

D.  MN-PQ

✓

Q100 Reasoning
Each vowel in the word FRANCHISEES is changed to the letter
immediately following it in the English alphabetical order and each
consonant is changed to the letter immediately preceding it in the
English alphabetical order. How many letters will appear exactly
twice in the group of letters thus formed?7651

A.  One

B.  Two

C.  Three

D.  Four
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